SCE Training Curriculum

Siemens Automation Cooperates with Education (SCE) | 09/2015

PA Module P02-01
SIMATIC PCS 7 – HMI Generation
Matching SCE Trainer Packages for these curriculum

• SIMATIC PCS 7 Software block of 3 packages
  Order No. 6ES7650-0XX18-0YS5
• SIMATIC PCS 7 Software block of 6 packages
  Order No. 6ES7650-0XX18-2YS5
• SIMATIC PCS 7 Software Upgrade block of 3 packages
  Order No. 6ES7650-0XX18-0YE5 (V8.0 → V8.1) or 6ES7650-0XX08-0YE5 (V7.1 → V8.0)
• SIMATIC PCS 7 Hardware Set including RTX Box
  Order No. 6ES7654-0UE13-0XS0

Please note that these trainer packages may be replaced with subsequent packages.
An overview of the available SCE packages is provided at: siemens.com/sce/tp

Continuing education
For regional Siemens SCE continuing education, contact your regional SCE contact partner.
siemens.com/sce/contact

Additional information relating to SIMATIC PCS 7 and SIMIT
In particular, Getting Started, videos, tutorials, manuals and programming guide.
siemens.com/sce/pcs7

Additional information relating to SCE
siemens.com/sce

Note on Usage
The training curriculum for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes at public educational and R&D facilities. Siemens AG is not liable for the contents.

This document may only be used for initial training on Siemens products/systems. This means it may be copied entirely or partially and handed to trainees for use within the scope of their training. Passing on or copying this document and communicating its contents is permitted within public training and continuing education facilities for training purposes.

Exceptions require written permission by Siemens AG. Contact person: Roland Scheuerer
roland.scheuerer@siemens.com.

Violators are subject to damages. All rights including translation rights are reserved, particularly in the event a patent is granted or a utility model or design is registered.

Usage for industrial customer courses is explicitly not permitted. We do not agree to the commercial utilization of these documents.

We would like to thank the Technical University Dresden, particularly Prof. Dr. Leon Urbas and Annett Krause, MS, as well as the Michael Dziallas Engineering Corporation and those who provided support in preparing this SCE training document.
HMI GENERATION

TRAINING OBJECTIVE

After working through this module, the students will be able to design and implement a graphic user interface for efficient process monitoring and control. To this end, they will be familiarized with the objective of process management. They understand the basic concepts of representation and are acquainted with different representation techniques. This enables the students to generate a graphic user interface in PSC 7 that is useful and efficient.

THEORY IN BRIEF

A modern process control system such as PSC 7 offers operating staff different screen based windows to the process; with it all process control tasks can be handled. Based on the large amount of information the operator has to take in and process from the technical process, structuring the information makes sense. In addition, certain rules have to be adhered to for navigation and representation in order to establish an interface to the technical process that can be operated well and that supports operators as well as possible in their manifold process control tasks.

PSC 7 supports the design process of process screens for operator control and monitoring in multiple ways. First, for many of the elementary blocks and individual control functions used in basic automation, operator icons and operator panels are defined that enable project-wide uniform interaction with similar technical equipment. Second, the plant hierarchy can be used to advantageously structure the represented information.

Based on this structure, very many elements of the operating system that have to be executed manually in other systems can be generated automatically and error-free by means of a generation run. The two essential remaining tasks when designing the process screens are the representation of the static process structure (containers, pipes, etc.) for better orientation, and inserting elements to navigate along process flows on a plant hierarchy level.

By means of the generation run, icons are set up for all operable blocks of a hierarchical level. The icons then only have to be moved and enhanced with static elements in order to obtain a complete operating screen (see Figure 1).
THEORY

OBJECTIVES OF PROCESS CONTROL

The task of an operator in a process plant is to perform the intended operation of this plant economically and environmentally sustainable. This task is called process management. Operators have to ensure consistently high product quality and amount (yield) and keep the amount of rejects as low as possible; they also have to compensate for disturbance factors such as varying characteristics of the raw material used and for faults in the plant or fluctuating throughput. Operators have to see to it that the availability and life of the plant is maximized. Moreover, they have to ensure that the emission limits are observed and energy and material consumption is minimized [1].

To attain these goals, operators have to be constantly in a position to monitor the plant, to diagnose faults and to intervene in the running process to remove faults. The operator's workplace is the operator station at a control desk. This operator station has available all displays and intervention capabilities that operators need to perform their tasks according to ability, skills and requirements [1].

CONCEPTS OF VISUALIZATION

The visualization of data and information in the graphical user interface has a deciding influence on operators' performance. For this reason, it has to be in line with their abilities, skills and requirements. The following questions should therefore be answered:

1. For whom and for what are we visualizing?
2. What is to be visualized?
3. How is it supposed to be visualized?

These questions depend on the plant to be configured and, therefore, have to be answered for the respective project. However, the following aspects always have to be considered:

Organization of what we want to visualize

The information and data to be visualized has to be organized suitably for the visualization. We have to specify how the existing elements are structured and arranged, how they relate to each other and how it is possible to navigate among the visualizations. To this end, we have to specify how much data and information is to be visualized overall (quantitative aspect). We also have to specify which information and data is to be visualized simultaneously and jointly (qualitative aspect).

We have to decide in this case what the ratio is to be of what is new (information, dynamic display share) to what is known (data, static display share). The aim is to share information as much as possible but with sufficient data for a correct interpretation of the information suitable to the purpose.

The result is the distribution of information and data to the different operating screens. Now, we still have to define how the operator gets from one operating screen to another (navigation).

Print growth

Depending on the user interface, only a limited area is available for simultaneously displaying data and information. To ensure that the information and the data is legible and distinguishable in all operating situations, only a certain share of this area is to be assigned characters. This share is called print growth of the visualization.

The recommended print growth depends on the type of characters and the display elements as well as on the necessary arrangement of these elements. Thus, it depends on the visualization technique used. For example, the print growth of a process flow diagram should be no more than 50%; for a message page, on the other hand, it may be up to 80% [1].
Coding

Coding specifies how certain information is represented. Information can be coded through color, shape, form, extension, direction (angle), position and dynamics (flashing). Uniform coding facilitates the assimilation and evaluation of information for the operator.

Good coding is clear, distinguishable and does not contradict existing conventions. For example, the color green should never be used for a STOP signal. If instead a red flashing signal would be used as coding for STOP, this coding should be used consistently for the entire user interface. Also, this coding should not be used for any other information in order to rule out confusion. In addition, good coding should be plausible: the operator learns and remembers it easily.

Conspicuousness

A central task of the user interface is directing the operator’s attention to important information. Because different information is usually displayed on an operating screen, it is advisable to design this information with varying conspicuousness corresponding to its relevance and priority. The more conspicuous the information, the sooner it is discovered. In addition, based on its conspicuousness, the operator recognizes the information that requires the most attention at the moment. Table 1 shows the stepped increase of conspicuousness of the visualization for different information, based on a few examples.

Table 1: Application of stepped conspicuousness according to [1]

<table>
<thead>
<tr>
<th>Combination of means</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contrast</strong></td>
<td><strong>Color</strong></td>
</tr>
<tr>
<td>high</td>
<td>X</td>
</tr>
<tr>
<td>high</td>
<td>X</td>
</tr>
<tr>
<td>high</td>
<td>X</td>
</tr>
<tr>
<td>high</td>
<td>X</td>
</tr>
<tr>
<td>high</td>
<td>-</td>
</tr>
<tr>
<td>medium</td>
<td>-</td>
</tr>
<tr>
<td>low</td>
<td>-</td>
</tr>
</tbody>
</table>
**Consistency**

Often, certain information occurs in several visualizations at the same time. In this case it is important that this information is visualized **consistently** in the entire user interface. This means the information looks identical in all visualizations, and behaves identically. The same terms and icons have to be used. The operation sequence should always be the same, and the system reaction to operations should be similar with respect to time and content.

**Visualization Techniques**

**Basic Structure of the Display Area**

The display area should always be structured the same for all types of visualization. For the operator, it facilitates orientation, information assimilation and thus process management.

The recommended basic structure according to VDI 3699 [1] is shown in Figure 2. A message line is located in the upper area where the most current messages are displayed as group messages. Below it is an overview field where the available visualizations (for example, process pictures in **PCS 7**) are listed. From here, any visualization can be opened. The working area occupies the largest part of the display area. Here, the currently selected visualization is displayed. The lowest area contains the key field for activating general functions. In the working area, windows with supplementary information (such as different views of **PCS 7** blocks) can be opened in addition. All areas except the working area are reserved and are permanently displayed.

![Basic structure of a display area](image)

Figure 2: Basic structure of a display area
Flowcharts

A flowchart is the "schematic representation of components including their connection through (flow) lines to show relationships in a control plant and in control engineering" [1]. It represents a simplified plant structure and provides information about the paths of material, energy and signal flows between the different plant units. With the aid of flowcharts, process and control information is represented and interventions in the process are made possible.

Flowcharts consist of static and dynamic elements. The static display elements are represented by the root screen. This root screen contains the dynamic display elements that are continuously updated.

The static root screen provides the context for the dynamic picture elements, which means it indicates the meaning of the represented objects and their relationship among each other. The root screen represents all data that remains unchanged during the display. This data is the display background, the headings and labels as well as the plant units and the devices (if their representation is not to change).

The dynamic picture elements provide the information for process control. Display elements represent the changes, characteristics and relationships of the process values. They reflect the state of the plant, of the control system or of the process. Selection and operator control elements make it possible for the operator to intervene for process control. Furthermore, additional information such as function charts or curves can be inserted in the flowchart as a window.

Flowcharts are subdivided as follows:

- Control flowcharts represent only the components of control systems such as regulators, sensors and controllers as symbols. They are connected to each other with signal flow lines.

- Process flowcharts graphically represent plant units in a simplified way using symbols. Here, three different kinds are differentiated:
  
  - A basic flowchart represents plants, sub-plants or plant units in the form of rectangles. They are connected to each other with flow lines for materials, energy or energy sources.
  
  - A process flowchart represents processes using (simplified) graphic symbols. The symbols represent the corresponding plant units and are connected to each other with flow lines.
  
  - A pipe and instrument diagram (P&I diagram) represents the technical equipment of the plant using graphic symbols. In addition, process tags, control blocks and actuators are represented. The symbols are connected to each other by lines for pipes and signal paths.

In PCS 7, flowcharts are called process pictures. In the step by step instructions, different process pictures are generated for the configured plant.
HMI GENERATION IN PCS 7

PCS 7 has an extensive operator control and monitoring system that consists of the following subsystems [2]:

– A graphic system for displaying process information and for process operation.
– A curve system to represent and analyze time sequences of stored process values.
– A message system for diagnosing the process.
– A log system for documenting the process.
– An archive system for storing and maintaining process values, messages and logs.

In this chapter, the PCS 7 graphic systems is introduced. The message system will be described in the subsequent chapter ‘Alarm Engineering’.

The graphic system represents the plant in a plant overview, shows process pictures in the working area of the user interface, makes available elements for process and system operation and indicates alarm states. The corresponding user interface is generated on the system’s operator station (OS). Thus, the OS is the central station for monitoring and operating a PCS 7 plant [2].

Configuring the User Interface in PCS 7

The selected plant hierarchy of the project is the basis for the organization of the user interface. The plants and subunits that were set up are represented in the user interface with corresponding process pictures. Picture names and directory names of the plant hierarchy are included automatically. In the process mode, the process pictures are represented in the overview area corresponding to the plant hierarchy.

First, the process pictures of a project are set up at the corresponding location in the plant hierarchy and assigned to an OS. The OS then has to be compiled. After that, the process pictures can be configured in the Graphics Designer of the WinCC Explorer. The Graphics Designer is an editor where static and dynamic picture elements can be inserted, arranged and interconnected.

Configuring the Process Pictures in PCS 7

Technological blocks from PCS 7 libraries that can be operated and monitored include corresponding graphic representations, so-called block icons. When the process pictures are configured, they are inserted automatically in the corresponding screen. Overview-like, block icons provide the most important information about the represented block in the process picture.

By means of the block icons, different pre-configured faceplates can be called that open as a window in the working area. Faceplates are dynamic diagram elements that are connected to the parameters of the represented block and are updated automatically. They make it possible for the operator to extensively monitor and operate the associated technological block. Depending on the block type, different views exist for the associated faceplates. These views enable the access to parameters for very specific tasks. For example, in addition to the standard view there often also is a parameter view for assigning parameters, a message view for diagnostics, or a limit view for setting operational limits of the setpoint. It depends on the represented technological block which views are offered.

The Graphics Designer makes additional dynamic standard objects available that can be inserted manually. These objects can be interconnected directly with the I/Os of the blocks in the CFCs and SFCs and thus realize the desired dynamic behavior. Examples for standard objects are input and output fields for entering and displaying values, status indicators for displaying binary states of an object as well as bars for the relative representation of values.
In addition, the **Graphics Designer** provides different libraries with pre-assembled graphic elements such as piping or valves that can be used to generate the static root screen. You can also create and use our own graphics.

In the step by step instructions below, additional characteristics and capabilities of the **Graphics Designer** are presented. Moreover, important **WinCC** tools are introduced.

**LITERATURE**


STEP BY STEP INSTRUCTIONS

TASK

In this task, the operator station (OS) is created after a few presettings on the SIMATIC Manager.

We are creating the following: an overview screen of the multi-purpose plant, and one unit picture each for the educt tank, the reactor and the product tank. First, a solution for a tank is generated for each unit.

TRAINING OBJECTIVE

In this chapter, the student:

– Learns to generate the operator station (OS) in the SIMATIC Manager
– Is familiarized with the WinCC configuration environment
– Learns to build pictures in the Graphics Designer

These instructions are based on ‘PCS7_SCE_0108_Ueb_R1504_en.zip’.

PROGRAMMING

1. First, change the object properties of your picture on level A1_multipurpose_plant.

   (→ A1_multipurpose_plant → Picture(2) → Object Properties)
2. As the name, enter ‘A1_multipurpose_plant’.
   (→ General → Name → A1_multipurpose_plant)

   ![Image of WinCC Picture Properties with 'A1_multipurpose_plant' entered as name](image1)

3. Derive the block icons from the plant hierarchy.
   (→ Block icons → Derive the block icons from the plant hierarchy)

   ![Image of WinCC Picture Properties with 'Derive the block icons from the plant hierarchy' checked](image2)
4. In the levels T1 to T4, insert pictures with a right click and ‘Insert New Object’. Assign names to them as shown in the example below for T2. (→ Insert New Object → Picture → Object Properties → Name)
5. Then, the block icons have to be generated and updated. (→ A1_multipurpose_plant → Plant Hierarchy → Create/Update Block Icons)

![Image of SIMATIC Manager interface](image1)

6. In the window that opens, set ‘Chart’ under ‘...components of the HID’ and the included lower level hierarchy levels to ‘1’. Confirm with ‘OK’. (→ Chart → Lower hierarchy levels included → 1 → OK)

![Image of Create/Update Block Icons window](image2)
7. Now the block icons are created and updated.

8. After Create/Update Block Icons, have the log displayed. (→ Yes)

9. The log shows that no errors occurred. (→ X)
10. We can now start compiling the OS from the Component view. (→ OS → PLC → Compile and Download Objects…)

11. Before starting, check the settings for compiling the OS. (OS(1) → Edit…)

![Image of SIMATIC Manager interface showing the process of compiling and downloading objects]
12. The assignment of areas to operator stations remains unchanged.

(→ Next)

13. In the next dialog step, the network connection is checked.

(→ S7-Program(1) → Select Network Connections...)
14. As WinCC Unit, TCP/IP should be set. (WinCC unit → TCP/IP → OK)

![Select Network Connection screenshot](image1)

15. Now go to the next dialog step. (→ Next)

![Settings: Compile OS screenshot](image2)
16. In the last setting window, apply the values shown below. (→ Apply)

![Settings: Compile OS](image1)

17. Because the operator station (OS) is started on the engineering system (ES) for this plant, we only select Compile here, not Download. After the compile run is started, the warning is confirmed with Yes. (→ Start → Yes)

![Compile and Download Objects](image2)

**If you want to download changes online, please make sure that the prerequisites have been met (e.g., correct settings selected, no previous complete compilation from the OS). A complete download is only possible if the PLCs are not in RUN.**

Do you want to continue?

Yes  No
18. The log that is now displayed shows no errors. (→)

19. After the compilation, the operator station can be opened (→ OS(1) → Open Object)
20. If the computer name in the WinCC project does not match the local computer name, you will receive the following message which you confirm with ‘Yes’. Then you should change the name of the computer. (→ Computer → Properties).

21. If the computer name is the same as the local computer name, no changes need be made. If the computer name does not match, it has to be set with the button ‘Use local computer name’. Exit the window with ‘OK’.

(→ Use local computer name → OK)
22. The change of the computer name is applied only after the restart. This means, you have to close WinCC if the computer name is changed.

![Change computer name]

23. The WinCC project can be reopened from the SIMATIC Manager.

![SIMATIC Manager - PCST_SCE_MP (Component view)]
24. To set the network configuration, open Tag Management.

(→ Tag Management → Open)

25. Here we can change the system parameters. To this end, select the system parameters in the SIMATIC S7 Protocol Suite under TCP/IP.

(SIMATIC S7 PROTOCOL SUITE → TCP/IP → System Parameter)
26. In the ‘Unit’ tab, set PLCSIM(TCP/IP) as the logical device name.

(→ Unit → Logical device name → PLCSIM(TCP/IP) → OK)

27. Now close Tag Management. (→ Close)
28. Once you have opened WinCC again, open the Picture Tree Manager.

(→ Picture Tree Manager → Open)

29. In the Picture Tree Manager we specify the sequence in which the pictures are called later. Retain the structure, save and close the editor. (→ Save → Close)
30. Then open the OS Project Editor. (→ OS Project Editor → Open)

31. In the OS Project Editor, we can now select under ‘Layout’ the motor configuration and the screen resolution. In addition, settings are provided for message display, the visible areas, window arrangement in the Runtime window, and other basic settings. Set the desired layout, the number of area keys and the monitor configuration. Exit the dialog with ‘OK’. (→ Select layout → Number of area keys: 4 → OK)
32. The operating screens are generated in the Graphics Designer. Individual screens are opened best by double clicking on the name in the window to the right.

(→ Graphics Designer → A1_multipurpose_plant)

33. The Graphics Designer provides the most diverse functions for generating process pictures. They can be hidden or shown in the menu with View/Tools.

(→ View → Toolbars)
These toolbars have the following functions:

- **Standard tools**: contains icons and buttons to carry out frequent commands quickly.
- **Color palette**: used to assign colors to selected objects (one of 16 standard colors or a user defined color).
- **Zoom palette**: sets the zoom factor (in percent) for the active window.
- **Style palette**: changes the appearance of a selected object. Depending on the object, the line/border type, the line/border weight, the line end styles or the fill pattern can be changed.
- **Standard**: contains the standard objects (polygon, ellipsis, rectangle, etc.), smart objects (OLE control, OLE element, EA field etc.) and Windows objects (button, check box etc.).
- **Dynamic Wizard**: provides a variety of frequently needed functions. They can be generated using a dialog that guides the operator and also lends support.
- **Layer palette**: selects which of the 32 levels (level 0 to 31) is visible. Level 0 is selected by default.
- **Alignment palette**: used to change the absolute position of one or several objects, to change the position of selected objects relative to each other, or unify the height and width of several objects.
- **Object properties**: enables you to view and change all properties of the selected object.
- **Object palette**: shows you which object is currently selected and offers different options for manipulation.

34. Through creating the faceplates, the block icons are already included in the pictures. They can be positioned within the pictures as desired.
35. In the properties of the block icons, the displayed name can be specified. Otherwise, a very long name is displayed that includes the path.

(→ Properties → Object name → A1_multipurpose_plant/SFC_Product01)
36. Now, we change the background color of the picture to white. To this end, left click in the background of the picture with activated object properties toolbar. The properties of the picture object open.

![Image of object properties](image)

37. For each object as well as the picture, a variety of properties is provided that can be changed statically or dynamically (for example, interfaced with process variables). Here, the background color is edited.

(→ Picture Object → Colors → Background Color → Edit)
38. Now, select white as the color (255 255 255). (White → OK)

39. For the change of the background color to become effective, the global color scheme has to be deactivated.

(→ Picture Object → Effects → Global Color Scheme → No)
40. Now, change the picture geometry for it to be shown completely at a resolution of 1024x768.

![Object Properties](image1.png)

41. Next, in the Standard palette, click on Rectangle and draw a large rectangle in the picture. (→ Standard palette → Rectangle)

![Standard palette](image2.png)
42. Arrange the icons for the SFCs as shown below next to the rectangle you just drew.

43. Open the selection for the toolbars if the Dynamic Wizard is not displayed yet.
   (→ View → Toolbars → Dynamic Wizard)
44. When the toolbar for the Dynamic Wizard is displayed, select here from the ‘Picture Functions’ the ‘Picture exchange in workspace’. (→ Picture functions → Picture exchange in workspace). For this function to be applied to the rectangle you have just created, it must be highlighted first.
45. Read the explanation and go to ‘Next’. (→ Next)

46. As trigger select ‘Mouse click’. (→ Mouse click → Next)
47. Now select the picture to which you want to change. (→ …)

![Picture selection interface]

48. In the picture browser, select T1_educt_tanks.Pdl. (→ T1_educt_tanks.Pdl → OK)

![Picture browser interface]
49. The name of the picture was accepted; continue. (→ Next)

![Image of set options window]

50. The wizard is closed with ‘Finish’. (→ Finish)

![Image of finished window]
51. If you would like to view the result, the mouse and the mouse action are located under 'Events'. With a double click on the icon you can then view the C-script that was generated.

(→Events → Mouse → Mouse Click → OK)
52. Using static texts, rectangles and the dynamic wizard, design your picture as shown here. It is absolutely necessary to ensure that the language 'View' menu corresponds to the desired target language. Here: English (United States).

53. The next picture we open is 'T1.educt_tanks' from the WinCC Explorer.
54. After you have changed the background—as in the picture multi-purpose plant—to the color white, open the library. (→ Display Library)
56. After the symbol for the pump, drag the valve symbol into the working field.

(→ Global Library → Symbols → Valves → 45)

57. The static symbols can be changed in their orientation by using the button Rotate.

(→ Rotate)
58. After you have inserted additional lines and text fields as shown here, draw a rectangle to represent the tank, and select its properties. (→ Rectangle → Properties)

59. To change the color, deactivate the global color scheme once again.
   (→ Properties → Effects → Global Color Scheme → No)
60. Now change the background color to white.

(→ Properties → Colors → Background Color)

61. Next, we configure a display of the digital level sensors. As shown here, draw a circle into the picture. Then, select its properties. (→ Circle → Properties)
62. To have the color displayed dynamically, deactivate the global color scheme.

(→ Properties → Effects → Global Color Scheme → No)

63. To implement a dynamic display, select the background color with the right mouse button and then the dynamic dialog.

(→ Properties → Colors → Background Color → Dynamic Dialog)

64. In the following dialog, first select Boolean as data type, then change the color at Yes/TRUE to green, finally select ‘Tag’ for the dynamic expression.

(→ Boolean → Yes/TRUE → → Tag)
65. At the variables, select as data source ‘STEP 7 Symbol Server’ and there, at the symbols, input I70.0 for the ‘level monitoring educt_tank B001 operating point H’.

(→ Data source → STEP 7 Symbol Server → A1.T1.A1T1L001.LSA+.SA+ / I70.0 / level monitoring educt_tank B001 operating point H → OK)

Note: If you use AS1/S7-400, select the symbols under S7 Program(1). If you are using the AS2/RTX Box, however, then you have to select the symbols under S7 Program (2).

66. We now apply the settings in the Dynamic Dialog. (→ Check → OK)

67. The steps shown above are also performed for the sensor ‘A1.T1.A1T1L001.LSA-.SA- / I70.1 / level monitoring educt_tank B001 operating point L’. Then, the elements shown here are jointly highlighted and grouped.
68. The group is then copied. (→ Copy)

69. Now we open the library and the group is inserted in the project library. Name the template ‘educt_tank_V1_0’. (→ Project Library → Insert)
70. Next, in the picture ‘T1_educt_tank.Pdl’ we position the faceplates for the valve ‘A1T1X004’ and for the pump ‘A1T1S001’ as shown here. It is advisable to bring the symbols within the layer to the very front so they can’t be covered up by other drawing elements. (Arrange → Within the Layer → Bring to Front).

71. The orientation of the dynamic valve faceplates is not yet correct. At runtime, the faceplates are animated in a way that in the closed state, they are situated transversely to the position of the pipe and rotate when opened in the position direction. However, this orientation can be changed only via the CFC of the
respective valve. To rotate a valve, first open the associated CFC and then the object properties of the valve block.

(→ Plant view → A1T1X004 → Valve → Object Properties)

72. Now, in the field Create block icon, enter a ‘2’. This rotates the icons by 90 degrees.

(→ Create block icon → 2 → OK)
73. After you have made the changes for all valves that are located in a vertical pipe compile the changes.

(→ SCE_PCS7_Prj → PLC → Compile and Download Objects → OS(1) → Edit)

74. In the last dialog for settings, enter the changes at Scope and then start compiling the OS. (→ Scope → Changes → Apply → Start)
75. In WinCC, the symbol of the valve—for which you made the change shown—is now rotated according to standard. Next, insert a static text ‘T1 educt_tank’; it facilitates orientation during operation. The result is shown below.
76. Just as for the picture `T1_educt_tank`, a tank/reactor is set up in the pictures `Product Tank` and `Reactors`. The two figures below can be used as examples. In addition, generate a template for the library from the one reactor as well as from the product tank.
77. To test the HMI with SIMIT and PCLSIM, the charts have to be downloaded to PLCSIM. The plant simulation in SIMIT also has to be started. Set the CPU to the RUN-P mode.

![Image of S7-PLCSIM1](image1)

78. In the WinCC Explorer, activation on the ES has to be allowed in the properties of the OS. (→ Properties → Allow activation on ES)

![Image of WinCC Explorer](image2)
79. Then, OS Runtime is activated (→ Activate)

80. First, open the plant overview by clicking on the area key ‘A1_multipurpose_plant’ in the overview area. (→ A1_multipurpose_plant)
81. Picture A1_multipurpose_plant with an overview of all areas of the plant and the sequential function charts (SFC) is shown.
82. By clicking on the block icon of the sequential function chart, an SFC can be opened and operated. (→ SFC_Product01 → Start → OK)
83. You get to the lower level layers either by opening the Picture Tree Navigator or by selecting the picture exchanges you generated.

(→ Arrow to the right of the A1_multipurpose_plant → T1_educt_tank)

84. In the operating screen of the educt tank, the faceplates for the valves and the pumps of this level are shown. The faceplates permit the operating mode change and operating the valves and pumps.
85. To operate a valve (here: open; click on the command button ‘…’ next to Close, select Open and confirm your selection with OK.

(→ … → Open → OK)

86. The open valve position is signaled through the rotation and the green coloring of the faceplate. Pumps can be controlled the same way.
87. The operator screen 'T2_Reaction' has a faceplate for the PID controller, in addition to the faceplates for valves and pumps, which can be operated and monitored through it.

(→ A1_multipurpose_plant → T2_Reaction → Temperature control)

88. The operating screen 'T3_product_tank' is represented with the faceplate for a valve whose operating mode is just being switched.

(→ A1_multipurpose_plant → T3_product_tank → Valve → ... → Manual → OK)
89. Runtime is terminated by first operating the button ‘keyset change’ in the lower control bar.

90. Then, select ‘Exit runtime’ and return to the WinCC Manager.
EXERCISES

In the exercises, we apply what we learned in the Theory section and in the Step by Step Instructions. To this end, we are using and expanding the existing multi-project from the step by step instructions (PCS7_SCE_0201_R1504_en.zip).

In the step by step instructions, only one element of the levels T1_educt_tank, T2_Reaction and T3_product_tank of the plant hierarchy was implemented. The objective of the exercise is to complete the pictures of the individual levels, or to generate the pictures of the missing levels.

Then, generate a picture for the level T4_Rinse.

TASKS

The tasks below are based on the step by step instructions. For each task, the corresponding steps of the instructions can be used as an aid. Regarding the arrangement, the rules of the VDI3699 [1] have to be noted.

1. Complete the picture of the levels T1_educt_tanks by adding the missing tanks A1T1B002 and A1T1B003. Use the template from the library for this so the representations will be consistent. Adapt the labeling of the tank and of the binary sensors. Do not forget to adapt the variables for visualizing the binary sensors. The valves and motors are already set up, they only have to be positioned. Note, however, that the valves may have to be rotated once more.

2. Now, also complete the pictures of levels T2_Reaction and T3_product_tank with the missing elements (tanks or reactors). Use the P&I diagram as a guide so that all valves, motors and controllers are positioned correctly. Take note of the correct rotation of the valves.

3. Finally, design the operating screen for the level T4_rinse. To this end, adapt the background analogous to the step by step instructions. Generate a picture title and a tank based on the educt and product tanks. Connect the variables of the binary sensors and arrange the valves and the motor using the P&I diagram as a guide.